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Notices

Copyright Notice

© Keysight Technologies 1997-
2020

No part of this document may
be reproduced in any form or by
any means (including electronic
storage and retrieval or
translation into a foreign
language) without prior
agreement and written consent
from Keysight Technologies,
Inc. as governed by United
States and international
copyright laws.

Warranty

The material contained in this
document is provided “as is,”
and is subject to being
changed, without notice, in
future editions. Further, to the
maximum extent permitted by
applicable law, Keysight
disclaims all warranties, either
express or implied, with regard
to this manual and any
information contained herein,
including but not limited to the
implied warranties of
merchantability and fitness for
a particular purpose. Keysight
shall not be liable for errors or
for incidental or consequential
damages in connection with the
furnishing, use, or performance
of this document or of any
information contained herein.
Should Keysight and the user
have a separate written
agreement with warranty terms
covering the material in this
document that conflict with
these terms, the warranty
terms in the separate
agreement shall control.

Technology Licenses

The hardware and/or software
described in this document are
furnished under a license and
may be used or copied only in
accordance with the terms of
such license.

U.S. Government Rights

The Software is "commercial
computer software," as defined
by Federal Acquisition
Regulation ("FAR") 2.101.
Pursuant to FAR 12.212 and
27.405-3 and Department of
Defense FAR Supplement
("DFARS") 227.7202, the U.S.
government acquires
commercial computer software
under the same terms by which
the software is customarily
provided to the public.
Accordingly, Keysight provides
the Software to U.S.
government customers under
its standard commercial
license, which is embodied in
its End User License Agreement
(EULA), a copy of which can be
found at
http://www.keysight.com/find
/sweula or
https://support.ixiacom.com/s
upport-services/warranty-
license-agreements. The
license set forth in the EULA
represents the exclusive
authority by which the U.S.
government may use, modify,
distribute, or disclose the
Software. The EULA and the
license set forth therein, does
not require or permit, among
other things, that Keysight: (1)
Furnish technical information
related to commercial computer
software or commercial

computer software
documentation that is not
customarily provided to the
public; or (2) Relinquish to, or
otherwise provide, the
government rights in excess of
these rights customarily
provided to the public to use,
modify, reproduce, release,
perform, display, or disclose
commercial computer software
or commercial computer
software documentation. No
additional government
requirements beyond those set
forth in the EULA shall apply,
except to the extent that those
terms, rights, or licenses are
explicitly required from all
providers of commercial
computer software pursuant to
the FAR and the DFARS and are
set forth specifically in writing
elsewhere in the EULA.
Keysight shall be under no
obligation to update, revise or
otherwise modify the Software.
With respect to any technical
data as defined by FAR 2.101,
pursuant to FAR 12.211 and
27.404.2 and DFARS 227.7102,
the U.S. government acquires
no greater than Limited Rights
as defined in FAR 27.401 or
DFAR 227.7103-5 (c), as
applicable in any technical
data. 52.227-14 (June 1987) or
DFAR 252.227-7015 (b)(2)
(November 1995), as
applicable in any technical
data.

Safety Information

Do not proceed
beyond a hazard
notice until the
indicated conditions

are fully understood and met.
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A CAUTION notice denotes a
hazardous situation that, if not
avoided, could result in minor
or moderate injury.

AWARNING notice denotes a
hazardous situation that, if not
avoided, could result in death
or serious injury.
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Contact Us

Ixia headquarters

26601 West Agoura Road

Calabasas, California 91302

+1 877 367 4942 – Toll-free North America

+1 818 871 1800 – Outside North America

+1.818.871.1805 – Fax

www.ixiacom.com/contact/info

Support

Global Support +1 818 595 2599 support@ixiacom.com

APAC Support +91 80 4939 6410 support-asiapac@ixiacom.com

EMEA Support +40 21 301 5699 support-emea@ixiacom.com

Greater China Region +400 898 0598 support-china@ixiacom.com

India Office +91 80 4939 6410 support-india@ixiacom.com

Japan Head Office +81 3 5326 1980 support-japan@ixiacom.com

Korea Office +82 2 3461 0095 support-korea@ixiacom.com

Singapore Office +656 494 8910 support-asiapac@ixiacom.com
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Documentation conventions
The following documentation conventions are used in this guide:

Describing interactions with the UI

You can interact with products by using different input methods: keyboard, mouse, touch, and more.
So in most parts of the user documentation, generic verbs have been used that work with any input
method. In cases where input-neutral verbs do not work, mouse-specific verbs are used as the first
choice, followed by touch-specific verbs as the second choice.

See the following table for examples on how you can interpret the different input methods.

Input-neutral Mouse Touch

Select Modify. Click Modify. Tap Modify.

Select Accounts > Other
accounts > Add an account.

Click Accounts > Other
accounts > Add an account.

Tap Accounts > Other
accounts > Add an account.

To open the document in Outline
view, select View > Outline.

To open the document in
Outline view, click View >
Outline.

To open the document in
Outline view, tap View >
Outline.

Select Protocols. Click the Protocols tab. Tap Protocols.

-NA- Double-click the Client wizard. Double-tap the Client wizard.

Open the Packages context
menu.

Right-click Packages to open
the shortcut menu.

Long tap Packages to open
the shortcut menu.

Deprecated words

The following words have been replaced with new words, considering the audience profile, our modern
approach to voice and style, and our emphasis to use input-neutral terms that support all input
methods.

Old usage... New usage...

shortcut menu, right-click menu context menu

click, right-click select

drag and drop drag

Documentation conventions
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CHAPTER 1 Overview of IxOS
This chapter provides a basic overview of IxOS.

About the Ixia Product Family
The Ixia system is the most comprehensive tool available for testing multilayer High Speed Ethernet,
10/100 Mbps Ethernet, Ethernet Gigabit, 10/40/100 Gigabit Ethernet, ATM, and Packet over SONET
switches, routers, and networks.

The Ixia product family includes chassis, load modules, the Ixia IxExplorer software program, and
optional Tcl scripts and related software. A chassis can be configured with any mix of load modules,
and multiple chassis can be connected in a daisy chain or star topology and synchronized to support
very large and complex test environments. The Ixia IxExplorer software provides complete
configuration, control, and monitoring of all Ixia resources in the test network, and the Tcl scripts allow
to rapidly conduct the most popular industry benchmark tests.

The XM12 provides high port density and hot swappable capability.

The XM2 is the next generation portable chassis that is a combination of the architecture with the XM
form factor. The XM2 provides hot-swappable capability in a more portable format.

The XGS12 Chassis – XGS12-SD and XGS12-HS are the next generation high performance platform
capable of supporting XM form factor load modules. XGS12-SD and XGS12-HS are 12-slot chassis with
high-speed backplane (160 Gbps between each adjacent two cards) designed for aggregation across
load modules. These chassis are capable of testing high density, multi-Terabit bandwidth, Carrier class
core edge, metro routers and data center switches. This flexible platform supports layer 2-7 testing on
a massive scale and provides the most comprehensive solution for performance, functional, security,
and conformance testing of network equipment and network applications.

The 2-slot XGS2 chassis - XGS2-SD and XGS2-HS provide highly flexible and portable chassis that
powers load modules and test applications to create an Ixia test system. The XGS2 platform provides
the foundation for a complete benchtop or rackmount test environment. The chassis platform supports
Ixia applications for performance, functional, conformance, and security testing.

A range of 1 to 48 ports can be packaged depending on network technology. An Ixia card is also
referred to as a load module. For most media, any combination of load modules may be included in a
single chassis. The highly scalable architecture supports daisy-chaining of up to 256 chassis that may
be locally synchronized. Thus, even the most complex systems can be tested thoroughly and cost-
effectively.

You can configure and control the unit directly through connections to a keyboard, mouse, monitor,
and printer. Also, the unit can be connected to an Ethernet network and an administrator can remotely
monitor and control it using the IxExplorer software program. Multiple users can access the unit
simultaneously, splitting the ports within a chassis and controlling the activity and configuration of all
ports and functions.

Chapter 1  Overview of IxOS
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Front panel displays give immediate indication of link state, transmission or reception of packets, and
error conditions. Ixia’s powerful IxExplorer and Microsoft Windows-based software provides easy
configuration, control, and status. The Ixia system offers an optional suite of scripts written in the
industry-standard scripting language Tcl, which stands for Tool Command Language (commonly
pronounced as tickle).

Each Ixia chassis is equipped with one or more Intel processors. The operating system installed on the
chassis may be Windows XP Professional or Windows 7 Professional.

Note: Ixia supports upgrades to the Microsoft operating system (OS) on Ixia chassis. Contact
Ixia Technical Support for assistance with Microsoft OS upgrade options.

Additional information on the operation of the Ixia chassis and load modules can be found in the other
Ixia guides, which include the following:

l IxExplorer User Guide: Provides information on the use of the Ixia IxExplorer GUI.

l Ixia Platform Reference Guide: Provides information on Ixia chassis and load modules, including
specifications.

l IxAutomate User Guide: Provides information on the use of the Ixia IxAutomate GUI, for
automated testing.

l Tcl Development Guide: Provides information on the Ixia Tcl API used in creating customized test
scripts.

Comprehensive Help is included in the IxExplorer GUI software.

Chapter 1  Overview of IxOS
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CHAPTER 2 Installation
This chapter describes the requirements for and provides detailed instructions for installing IxOS. It
contains the following topics:

l Unpacking the Ixia Chassis

l Notes, Cautions and Warnings

l Installation

l Windows XP Professional Configuration

l Windows 7 Configuration

l Windows 10 Configuration

l File-Sharing

l Local/Remote Operation

l UNIX Installation Notes

l Unix/Linux Operation

l Powering Up

l Shutting Down

l Software Installation for Remote Operation

l Server Operation Option

l Hardware Manager Options

l Installing a Demonstration IxServer

l Shell Wrapper Installation

l Automatic Update Feature

l IxOS Silent Install

l Uninstall/Modify a Current Installation

l Multi-Version Installation and Management

l Repair, Modify, Uninstall using Windows Control Panel

Unpacking the Ixia Chassis
Each chassis comes packed in its own box. Carefully remove all of the pieces from the box and check
that you have all the components as mentioned in the following list:

l IXIA chassis

l Power cord

l Right and left ear brackets and screws, for rack mounting (for XM2)

Chapter 2  Installation
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l Chassis sync cable

l The following documentation items, possibly shipped separately:
o Windows XP or Windows 7 Professional certificate of authenticity
o Getting Started Guide

Notes, Cautions and Warnings
Power Cords

Power cords that are included in shipments of Ixia equipment meet the approved/recognized standards
of the national safety organization(s) of the destination country.

Use the power cord provided or a power cord approved by the appropriate agency for use in the country
where the unit is being used. The power source should be properly grounded.

Battery Replacement

Danger of explosion if battery is incorrectly replaced. You should not attempt to replace the battery.

Return to Ixia Customer Service for replacement with the same or equivalent type of battery. Ixia
disposes of used batteries according to the battery manufacturer's instructions.

Ventilation Requirements

The following caution applies to equipment installed into equipment racks:

Reduced Air Flow—Install the equipment in a rack so that the amount of air flow required for safe
operation of the equipment is not reduced.
Do not block the back or sides of the chassis, and leave approximately two inches of space around the
unit for proper ventilation. Do not block any ventilation apertures on any chassis.Clean ventilation
intake grills periodically to permit good airflow intake.

Voltage

Ixia chassis use voltage from 100 VAC to 240 VAC at 50/60 Hz. Current is from 2.25 A to 20 A.

Rack Mounting

Two rack-mount ears and black flat-head screws are provided (for chassis that may be rack-mounted).
These are designed to fit a generic 19-inch electronic rack. First, attach the ears to the unit, and then
attach the unit by the ears to the rack by a method appropriate for the rack.

Chapter 2  Installation
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Rack Mounting Precautions

If the chassis is installed in a Rack Mount, observe the following precautions:

a. Elevated Operating Ambient Temperature: If installed in a closed or multi-unit rack assembly, the
operating ambient temperature of the rack environment may be greater than room ambient
temperature. Therefore, consider installing the equipment in an environment that is compatible
with the maximum allowable ambient temperature specified for the chassis (40° C).

b. Reduced Air Flow: Install the equipment in a rack so that the amount of air flow required for safe
operation of the equipment is not reduced.
Do not block the back or sides of the chassis, and leave approximately two inches of space
around the unit for proper ventilation.

c. Mechanical Loading: Mount the equipment in the rack so that a hazardous condition is not caused
due to uneven mechanical loading.

d. Circuit Overloading: Consider the connection of the equipment to the supply circuit and the effect
that overloading of the circuits might have on current protection and supply wiring. Pay attention
to equipment nameplate ratings when addressing this concern.

e. Reliable Earthing: Maintain reliable earthing (grounding) of rack-mounted equipment. Pay special
attention to supply connections other than direct connections to the branch circuit (such as use of
power strips).

Use End Caps on Open Ports

The metal edges of the SFP and SFP+ ports are SHARP. To avoid injury, ALWAYS keep unused SFP
ports covered with end caps. When installing a load module into a chassis or removing from a chassis,
ensure that the end caps are in place on unused ports.

To prevent accidental injury to personnel, do not leave unused SFP (or SFP+) ports uncovered. When
transceivers are not installed, end caps must be used.

Chapter 2  Installation
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Figure: Contact Ixia Technical Support to obtain end caps

Affected load modules include the following:

l NGY with SFP+ interface, 2/4/8-port, all models

l Dual PHY SFF cards with RJ45 and SFP Gigabit (TXS and STXS)

l ACCELERON-NP and -XP

l LSM1000XMV 4/8/12/16-port, all models

l LSM1000XMS12/12R

l ASM1000XMV12X/12XRTP

Use Ejector Tabs Properly

Ejector tabs on load modules are to be used only to eject a load module from the chassis backplane
connector. They are not designed to support the weight of the load module. Ejector tabs can bend if

Chapter 2  Installation
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used improperly as handles to push, pull, or carry a load module.

Do not use ejector tabs as handles to support a load module while installing and fitting into the
chassis. The ejector tabs are to be used only to eject the module from the chassis backplane
connector.

Maintenance Instructions

The only user maintainable feature is changing the fuse, if it blows. Replace the fuse only with one of
the same size and rating. The fuse drawer, located near the power cord receptacle, pulls out with a
small flat-bladed screwdriver. Note that repeated fuse blowing may likely indicate some internal
problem; you should report the problem to Ixia Technical Support.

We recommend cleaning of the ventilation intake grills periodically to permit good airflow intake.

Calibration of the Ixia chassis is not required. There are no adjustable components in any Ixia chassis.

China RoHS Declaration

The China RoHS Declaration can be found in the Ixia Platform Reference Guide, in the Chapter titled
About This Guide.

Cautions

XM12 Caution

The following cautions and warnings apply to the XM12 chassis.

The socket/ outlets used to power the unit must be installed near the equipment and must be easily
accessible because the power plug may be used to disconnect the unit from the power source.

Chapter 2  Installation
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XM2, XGS2-SD, and XGS2-HS Caution

The following caution applies to XM2, XGS2-SD, and XGS2-HS chassis:

The chassis units can only be operated in the horizontal position.

XGS12-HS, XGS2-SD, XGS2-HS, and XGS12-HS Caution

The following caution applies specifically to XGS12-SD, XGS12-HS, XGS2-SD, and XGS2-HS chassis:

Battery replacement: Danger of explosion if battery is incorrectly replaced. You should not attempt to
replace the battery. Return to Ixia Customer Service for replacement with the same or equivalent type
of battery. Ixia disposes off used batteries according to the battery manufacturer's instructions.

Installation
The Ixia Chassis comes preloaded with IxServer and IxExplorer software along with Windows 7
Professional. The chassis includes an internal industry standard computer hardware platform. To
perform initial configuration, it is necessary to obtain the components mentioned here and to attach
them to the appropriate connectors on the back or front of the chassis:

l SVGA monitor

l PS/2-style keyboard

l PS/2-style mouse

Debugability Daemon
When you install IxOS on the chassis, the debugability daemon is also installed along with it. This
daemon provides communication and debugability services such as IxLogger and Correlation Engine. It
also provides visibility over the ports to the client, so that when the client uses the chassis, the ports
are visible directly.

Note: Ixia supports upgrades to the Microsoft operating system (OS) on Ixia chassis. Contact
Ixia Technical Support for assistance with Microsoft OS upgrade options.

Chapter 2  Installation
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Note: Any Ixia chassis must be always operated with the chassis cover closed and with all card
face plates mounted.

Initial Chassis/Peripheral Connection
To perform initial chassis configuration for Windows XP Professional, a monitor, keyboard, and mouse
must be connected to the chassis.

To configure TCP/IP, do the following:

1. Attach the monitor, keyboard and mouse to the ports on the back of the XGS12-SD chassis, or
the front of the XM12 chassis as shown in the following figures.

Figure: Rear View of IXIA XGS12-SD Chassis with USB Keyboard and Mouse

Chapter 2  Installation
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Figure: Front View of XM12 Chassis Connectors

Figure: Front View of XM12 Chassis with PS-2 Keyboard, Mouse, and Monitor

2. Attach the power cord to the chassis and then to the wall socket. Switch the master power switch
to ‘1’ (on).

3. Power on the chassis by pressing the power button in the front of the chassis.

4. Verify that the IxServer window appears as shown in the following figure:

Chapter 2  Installation
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Figure: Initial Window Display from Locally Connected Monitor

Windows XP Professional, Windows 7 and Windows 10
Configuration
The Windows XP Professional and Windows 7 configuration procedure is explained in the following
sections.

Windows XP Professional TCP/IP Configuration

The network address of the chassis must be set, even if the network is not used.

1. To do this, select in the following sequence of items: Start (in the lower left-hand corner of your
computer screen), Settings, Network and Dial-up Connections, and Local Area
Connection, as shown in the following figure:

Chapter 2  Installation
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The Local Area Connection Status window opens, as shown in the following figure:

2. Select Properties, and the Local Area Connection Properties window opens, as shown in
the following figure:

Chapter 2  Installation
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3. In the Local Area Connection Properties window, select the check box for the following item:

l Internet Protocol (TCP/IP)

4. Double-click the Internet Protocol TCP/IP entry or select Properties to open the Internet
Protocol (TCP/IP) Properties window as shown in the following figure:

Chapter 2  Installation
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5. This setting reflects the default factory setup for your chassis. It is configured to use DHCP to
discover all network aspects for your chassis. If you have a DHCP server computer on the network
attached to the chassis, this is the appropriate configuration of your chassis; proceed to step 11.
If no DHCP server computer is found on the network, Windows XP Professional automatically
assigns a unique IP address in the 169.254.0.0–169.254.255.255 range. Again this might be
appropriate for your network. If you need to assign a particular IP address to your chassis, fill in
the fields as shown in the following figure and explained in Table: Internet Protocol
(TCP/IP) Settings.

Property
Sheet Category Parameter Usage

General Obtain an IP
address
automatically

If selected, the fields for IP address are disabled, and the
Obtain DNS server address automatically option is enabled.

Use the
following IP
address:

If selected, the sub-fields under this option are enabled for
manual configuration of the IP address information.

IP Address The single IP address for this chassis.

Subnet Mask The IP subnet mask to be used with this IP address.

Default The IP address of the gateway for the network.

Table: Internet Protocol (TCP/IP) Settings

Chapter 2  Installation
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Property
Sheet Category Parameter Usage

Gateway

Obtain DNS
server address
automatically

If selected, the IP address for the server computer providing
Domain Name Service (DNS) for name resolution is obtained
automatically from the local DHCP server computer.

Use the
following DNS
server
addresses

If selected, the sub-fields under this option are enabled for
manual entry of the IP addresses for the DNS servers.

Preferred DNS
server:

The IP address for the preferred DNS server.

Alternate DNS
server:

The IP address for an alternate DNS server.

Advanced If selected, the Advanced TCP/IP Settings dialog box appears.

1. You need to refer to the Host ID at a later time when running IxExplorer. This name must be
assigned in the My Computer > Identification Changes window. First, select My Computer
icon on the desktop and open the context menu as shown in the following figure:

2. Select Properties. The System Properties window appears as shown in the following figure:

Chapter 2  Installation

– 15 –



3. On the Computer Name tab, select Change. The Computer Name Changes window appears
as shown in the following figure:

4. The ‘Computer Name’ shown in Figure: Computer Name Changesis an example of the
preconfigured name assigned to each chassis. Each chassis’ name is of the form <TYPE>-
<SERIALNO>. <TYPE> indicates the type of chassis. <SERIALNO> is the chassis serial number
and is always six digits long. By default, each chassis is also a member of the IXIA workgroup.
This may be changed at this time to another workgroup or as a member of a Windows 2000/XP
domain. If any change has been made, Windows asks you if you wish to restart. Answer ‘YES.

Chapter 2  Installation
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Note: Changing a chassis name requires updating your license. See Regular License
Installation.

Windows XP Professional General Configuration

The Windows XP Professional initial configuration includes some features that make the chassis more
robust and easier to use. The features are mentioned in the following list:

1. The latest Windows XP Professional Service Pack has been applied. This Microsoft Certified
software increases the operating system security.

2. The time zone of the computer has been set to UTC, with Daylight Saving Time disabled. To
change this, do the following:
i. Select the time in the notification area and select Adjust Date/Time from the context
menu, as shown in the following figure:

The Date/Time Properties window appears.

Chapter 2  Installation
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ii. Select the Time Zone tab from the window and adjust the time zone and daylight savings
time settings as appropriate, as shown in the following figure. Return to the Date & Time
tab to set the current time in your time zone.

Chapter 2  Installation
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3. An NTP (Network Time Protocol) service automatically runs. If your chassis is connected to the
Internet, it keeps the system clock on your chassis accurate. If your chassis is not connected to
the Internet, the NTP service has no adverse effects.

4. An anti-virus scanner is installed, but it does not run a scheduled full system scan.

Windows XP Professional Security Settings

The user name for the administration level account is ixia, with a password consisting of second half of
the chassis serial number. For example, if the chassis’ serial number is 400-1234567, the account
name is ixia and the password is 1234567.

The administrator is responsible for system maintenance and may perform any operation on the
system. The ixia user is automatically logged on when the chassis is powered on.

Windows 7 TCP/IP Configuration

The network address of the chassis must be set, even if the network is not used.

1. To do this, select the following sequence of items: Start (in the lower left-hand corner of your
computer screen), Control Panel, Network and Internetand Network and Sharing
Center. You can view your basic network information and set up connections.

2. Select Local Area Connection. The Local Area Connection Status window appears.
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3. Select Properties. The Local Area Connection Properties window opens, as shown in the
following figure:

4. Double-click the Internet Protocol Version 6 (TCP/IPv6) entry or select Properties to
open the Internet Protocol Version 6 (TCP/IPv6) Properties window as shown in the
following figure:

Chapter 2  Installation
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5. This setting reflects the default factory setup for your chassis. It is configured to use DHCP to
discover all network aspects for your chassis. If you have a DHCP server computer on the network
attached to the chassis, this is the appropriate configuration of your chassis; proceed to step 11.
If no DHCP server computer is found on the network, Windows 7 automatically assigns a unique
IP address in the 169.254.0.0–169.254.255.255 range. Again this might be appropriate for your
network. If you need to assign a particular IP address to your chassis, fill in the fields as
explained in Table: Internet Protocol (TCP/IP) Settings

Category Parameter Usage

General Obtain an IP
address
automatically

If selected, the fields for IP address are disabled, and the Obtain
DNS server address automatically option is enabled.

Use the
following IP
address:

If selected, the sub-fields under this option are enabled for manual
configuration of the IP address information.

Table: Internet Protocol (TCP/IP) Settings
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Category Parameter Usage

IP Address The single IP address for this chassis.

Subnet Mask The IP subnet mask to be used with this IP address.

Default
Gateway

The IP address of the gateway for the network.

Obtain DNS
server address
automatically

If selected, the IP address for the server computer providing
Domain Name Service (DNS) for name resolution is obtained
automatically from the local DHCP server computer.

Use the
following DNS
server
addresses

If selected, the sub-fields under this option are enabled for manual
entry of the IP addresses for the DNS servers.

Preferred DNS
server:

The IP address for the preferred DNS server.

Alternate DNS
server:

The IP address for an alternate DNS server.

Validate
settings
upon exit

If selected, the IP address settings are verified when
you exit.

Advanced If selected, the Advanced TCP/IP Settings dialog box
appears.

6. You need to refer to the Host ID at a later time when running IxExplorer. This name must be
assigned in the Computer-System Properties window. First, select Computer icon on the desktop
to open the context menu as shown in the following figure:
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7. Select Properties . You can view the basic information about your computer as shown in the
following figure:

8. Select Change settings. The System Properties window appears as shown in the following
figure:

9. The Computer Name shown in the System Properties window is an example of the pre-
configured name assigned to each chassis. Each chassis’ name is of the form <TYPE>-
<SERIALNO>. <TYPE> is corresponding to the type of chassis. <SERIALNO> is the chassis serial
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number and is always six digits long. By default, each chassis is also a member of the IXIA
workgroup. This may be changed at this time to another workgroup or as a member of a Windows
2000/XP domain. If any change has been made, Windows asks you if you wish to restart. Answer
‘YES.’

Note: Changing a chassis name requires updating your license. See Regular License
Installation.

Windows 7 General Configuration

The Windows 7 initial configuration includes some features that make the chassis more robust and
easier to use. The features are mentioned in the following list:

1. The latest Windows 7 Service Pack has been applied. This Microsoft Certified software increases
the operating system security.

2. The time zone of the computer has been set to UTC, with Daylight Saving Time disabled. To
change this, do the following:
i. Select the time in the notification area and select Adjust date/time from the context
menu, as shown in the following figure.

The Date and Time window appears.
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ii. Select Change time zone and adjust the time zone and daylight savings time settings as
appropriate, as shown in the following figure. Return to the Date and Time tab to set the
current time in your time zone.

3. An NTP (Network Time Protocol) service automatically runs. If your chassis is connected to the
Internet, it keeps the system clock on your chassis accurate. If your chassis is not connected to
the Internet, the NTP service has no adverse effects.

4. An anti-virus scanner is installed, but it does not run a scheduled full system scan.

Windows 7 Security Settings

The user name for the administration level account is ixia, with a password consisting of second half of
the chassis serial number. For example, if the chassis’ serial number is 400-1234567, the account
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name is ixia and the password is 1234567.

The administrator is responsible for system maintenance and may perform any operation on the
system. The ixia user is automatically logged on when the chassis is powered on.

Windows 10 TCP/IP Configuration

The network address of the chassis must be set, even if the network is not used.

1. To do this, select the following sequence of items: Start (in the lower left-hand corner of your
computer screen), Control Panel, Network and Internet and Network and Sharing
Center. You can view your basic network information and set up connections.

2. Select Ethernet. The Ethernet Status window appears.
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3. Select Properties. The Ethernet Properties window opens, as shown in the following figure:
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4. Double-click the Internet Protocol Version 6 (TCP/IPv6) entry or select Properties to open the
Internet Protocol Version 6 (TCP/IPv6) Properties window as shown in the following
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figure:

5. This setting reflects the default factory setup for your chassis. It is configured to use DHCP to
discover all network aspects for your chassis. If you have a DHCP server computer on the network
attached to the chassis, this is the appropriate configuration of your chassis; proceed to step 11.
If no DHCP server computer is found on the network, Windows 10 automatically assigns a unique
IP address in the 169.254.0.0–169.254.255.255 range. Again this might be appropriate for your
network. If you need to assign a particular IP address to your chassis, fill in the fields as shown in
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the following figure and explained in Table: Internet Protocol (TCP/IP) Settings.

Category Parameter Usage

General Obtain an IP
address
automatically

If selected, the fields for IP address are disabled, and the Obtain DNS
server address automatically option is enabled.

Use the following
IP address:

If selected, the sub-fields under this option are enabled for manual
configuration of the IP address information.

IP Address The single IP address for this chassis.

Subnet Mask The IP subnet mask to be used with this IP address.

Default
Gateway

The IP address of the gateway for the network.

Obtain DNS
server address

If selected, the IP address for the server computer providing Domain
Name Service (DNS) for name resolution is obtained automatically from

Table :Internet Protocol (TCP/IP) Settings
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Category Parameter Usage

automatically the local DHCP server computer.

Use the following
DNS server
addresses

If selected, the sub-fields under this option are enabled for manual entry
of the IP addresses for the DNS servers.

Preferred DNS
server:

The IP address for the preferred DNS server.

Alternate DNS
server:

The IP address for an alternate DNS server.

Validate
settings upon
exit

If selected, the IP address settings are verified when you
exit.

Advanced If selected, the Advanced TCP/IP Settings dialog box
appears.

6. You need to refer to the Host ID at a later time when running IxExplorer. This name must be
assigned in the Computer-System Properties window.
First, select the the Computer icon on the desktop to open the context menu as shown in the
following figure:
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7. Select Properties. You can view the basic information about your computer as shown in the
following figure:
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8. Select Change settings. The System Properties window appears as shown in the following
figure:

9. The Computer Name shown in the System Properties window is an example of the pre-
configured name assigned to each chassis. Each chassis’ name is of the form <TYPE>-
<SERIALNO>. <TYPE> is corresponding to the type of chassis. <SERIALNO> is the chassis serial
number and is always six digits long.
By default, each chassis is also a member of the IXIA workgroup. This may be changed at this
time to another workgroup or as a member of a Windows 2000/XP/7/10 domain.
If any change has been made, Windows asks you if you wish to restart. Answer ‘YES.’

Windows 10 General Configuration

The Windows 10 initial configuration includes some features that make the chassis more robust and
easier to use. The features are mentioned in the following list:

1. Unlike Windows 7 which only received one major Service Pack update, Microsoft frequently
works on big updates to Windows 10.
New features are introduced on a regular basis in the Windows 10 operating system.

2. The time zone of the computer is set to UTC, Coordinated Universal Time. To change this, do the
following:
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i. Select the time in the notification area and select Adjust date/time from the context
menu, as shown in the following figure.

The Date and Time window appears.
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ii. Select Change time zone and adjust the time zone and daylight savings time settings as
appropriate, as shown in the following figure. Return to the Date and Time tab to set the
current time in your time zone.
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3. An NTP (Network Time Protocol) service automatically runs. If your chassis is connected to the
Internet, it keeps the system clock on your chassis accurate. If your chassis is not connected to
the Internet, the NTP service has no adverse effects.

4. An anti-virus scanner is installed, but it does not run a scheduled full system scan.

Windows 10 Security Settings

The user name for the administration level account is ixia, with a password consisting of second half of
the chassis serial number. For example, if the chassis’ serial number is 400-1234567, the account
name is ixia and the password is 1234567.

The administrator is responsible for system maintenance and may perform any operation on the
system. The ixia user is automatically logged on when the chassis is powered on.

File-Sharing
To protect Ixia chassis from virus attacks, Ixia has secured the chassis from unsafe remote access.
This was started with chassis shipped or repaired on and later than August 1, 2004. By default,
Microsoft NetBIOS file sharing mechanisms are disabled on Ixia chassis. The chassis is not able to
browse through the network, join a domain, or have open file shares. To allow a means of file transfer
to and from a chassis, an FTP server computer has been included and enabled on the chassis.

A remote user, logged into another computer, may look at or deposit files on a chassis by using FTP.
When accessing a chassis’ FTP server computer, the C: drive is set to read-only and the D: drive is set
to read/write. The intent is that software updates be deposited on the D: drive, and then locally
installed from the chassis’ console. To view the contents of the chassis C: drive, type ftp://TTT-
nnnnnn/ into your browser, as shown in Figure: FTP Access to a Chassis’ C: Drive.

To access a chassis’ D: drive, just append a d: to the URL, as shown in Figure: FTP Access to a
Chassis D: Drive.

Software may be copied to the folder shown on the browser’s screen by drag-and-drop operations.
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Figure: FTP Access to a Chassis’ C: Drive

Figure: FTP Access to a Chassis D: Drive

Local/Remote Operation
The IxExplorer software is the primary tool for navigation, configuration, and control of the Ixia
hardware. You may use IxExplorer either from the monitor attached directly to the chassis or from a
system connected to the network attached to the chassis. After initial configuration, the monitor,
keyboard, and mouse need not remain attached to the chassis. If the IxExplorer software is to be used
from a remote system, the software must be installed there.

Chapter 2  Installation

– 37 –



UNIX Installation Notes
To run the GUI installer, your client computer must be configured with an operational X-windows server
computer.

Be sure to set your DISPLAY environment variable to the host name or IP address of the client
computer on which you want the installer GUI to display. The following examples explain the setting of
the DISPLAY environment variable using various shells. If you need environment configuration
assistance beyond this, consult your System Administrator.

// enable connections to X Server
xhost + or xhost [remote hostname]

// set DISPLAY environment variable
// determine shell
echo $SHELL

// depending on what shell you use - Bourne shell (bsh or sh),
// Bash (bash- Bourne shell again), C shell (csh) or Korn shell (ksh);
// set DISPLAY environment variable:

// bash:
export DISPLAY=hostname:0

// bsh or ksh:
DISPLAY=hostname:0
export DISPLAY

// csh:
setenv DISPLAY hostname:0

If you are updating an existing installation, be sure to run the installer as the same user who initially
installed the software.

Always run the uninstaller before removing any files manually.

If you are installing as the root user using an install location in a network-mounted file system, ensure
that you have write permission to the file system.

To install the Tcl Client on Linux computer, perform the following steps: (note that the binary file name
‘IxOS<version>Linux.bin’ is used in the following example. In most cases, the file name is different)

1. Download either the ZIP, BIN or TAR file from the Ixia Web site.

2. Extract and copy all folders and files from the ZIP, BIN or TAR file into the lib folder of the IxOS
client installation.

3. Copy the IxOS<version>Linux.bin file to the Linux system.

4. Change the file's attribute to make it executable. Example: chmod +x IxOS<version>Linux.bin

5. Execute the IxOS installer file (use the –i gui option if your Linux version supports a graphical
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user interface). Example: ./IxOS<version>Linux.bin

6. When the installer prompts you, select Tcl version 8.5 (required).

7. Follow the rest of the instructions to complete the installation.

8. Follow the installation prompts to complete the installation.

9. After installation, set the following variables
Note: The following examples match the sample installation, you must alter these
paramets to match your installation.

export IXIA_HOME=/opt/ixia/tcl/8.5.17.0 IXIA_VERSION=9.10.XXX.XXX
export TCLLIBPATH=$IXIA_HOME/lib 10.

10. Alternatively, specify the following environment variable to specify the location ,the log, sample,
and results files for IxOS:

IXIA_LOGS_DIR=/tmp/Ixia/Logs
IXIA_RESULTS_DIR=/tmp/Ixia/Results
IXIA_SAMPLES=/tmp/Ixia//samples IXIA_TCL_DIR=$IxiaLibPath
1. If the Tcl option was installed with an IxOS installation, add Ixia's bin and lib folder to the PATH

and LD_LIBRARY_PATH variable to use it.

For example: IxiaLibPath=$IXIA_HOME/lib
IxiaBinPath=$IXIA_HOME/bin
PATH=$IxiaBinPath:.:$TCLBinPath:$PATH
LD_LIBRARY_PATH=$IxiaLibPath:$LD_LIBRARY_PATH

If the installation fails, check that there is enough disk space on the system by using the df -ak
command.

There must be enough space in the /tmp folder to extract the files, and also in the target folder where
the files are to be installed. If the /tmp directory does not have enough space, specify the directory.
You can do this by setting IATEMPDIR environment with path to the folder where you have enough free
space. The following example shows the use of the options:

export IATEMPDIR=<tempdir>

./IxOS8.00.XXX.XXXLinux.bin

Note: For 64-bit Linux systems, you should use the ixosX.XX.XXX.XXXLinux64.bin. The
installation is the same as described in the previous procedure.

Unix/Linux Operation
Though IxExplorer is a Windows-only application, you can access the IxOS hardware and software from
a UNIX or Linux environment by installing a Tcl client on the UNIX/Linux computer. The client computer
connects to IxTclServer on the chassis.
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For specific information on how to use IxTclServer and the Tcl client, see the IxOS Tcl Development
Guide.

There is also support for 64-bit Linux and the installer is ixos8.00.XXX.XXXLinux64.bin.

Powering Up
To power the chassis, press the power button in the front of the chassis. If a monitor is connected to
the chassis, the initial window appears as is shown in Figure: Initial Window Display from
Locally Connected Monitor.

The IxServer software is the agent that interfaces directly to the hardware of the chassis. It is started
automatically at power-up and the software’s viewable output is primarily intended as a diagnostic tool
for the Ixia hardware. IxExplorer can now be started locally by double-clicking the IxExplorer icon on
the Windows desktop, as shown in the following figure:

Note: Except for chassis designed for HOT SWAPPING (that is, the XM12, and XM2), the chassis
must be powered off before installing or removing load modules.

Shutting Down
To shut down the chassis, if you are using the monitor attached to the chassis itself, you can use any
of the three following techniques:

l From IxExplorer, select the chassis in the tree view, select Tools and choose Shutdown.

l Close IxExplorer, and shut down Windows by using the Shutdown option from the Start menu.

l Press the power button in front of the chassis.

If you are using IxExplorer remotely, you can shut down the chassis by:

l From IxExplorer, select the chassis in the tree view, select Tools and select Shutdown.

If no monitor attached directly to the chassis, you can also:

l Press the power button in front of the chassis.

All of these options invoke shutdown of Windows, and turn off the power supply in the chassis. When
the chassis is powered off but still getting AC power, the yellow ‘Standby’ LED on the front of the
chassis is lit. Try to avoid powering down the unit by removing AC power or turning off the power switch
at the AC power input module on the rear of the chassis, as this may cause file system problems.
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Installing and Removing Load Modules

Installing Load Modules
To install a load module, do the following:

1. Support the bottom of the load module with one hand, while gripping the front of the load module
with the other hand Figure: Safely Support Load Module.

Note: Ensure that end caps are in place on unused ports. See topic Use End Caps on Open
Ports

2. Align bottom of load module onto the guide rail in the chassis slot.

Figure: Safely Support Load Module

3. Gently slide the load module into the slot by pushing on the front of the load module.

Do not use ejector tabs as handles to support the load module while installing and seating into
the chassis. The ejector tabs are to be used only when ejecting.

4. Push the load module firmly into the backplane connector Figure: Seat the Load Module into
Backplane Connector. The load module must be firmly seated into the connector.

Figure: Seat the Load Module into Backplane Connector
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Removing a Load Module from the Chassis
To remove a load module from the chassis, do the following:

1. Press the ejectors at top and bottom of load module front, to release the load module from the
backplane connector Figure: Press Ejectors to Eject Load Module.

Figure: Press Ejectors to Eject Load Module
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2. Gently grip the ejectors and pull the load module a short way—about 1 inch (3 cm)—out of the
chassis Figure: Pull Ejectors to Start Load Module Removal.

Do not use ejectors to support the weight of the load module. They are not intended to support
the weight.

Figure: Pull Ejectors to Start Load Module Removal
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3. Grip the front of the load module and pull it out of the chassis (see Figure: Grip Front of Load
Module to Pull It Out). When the load module is partially out, support the bottom of the load
module, as shown in Figure: Safely Support Load Module.

Figure: Grip Front of Load Module to Pull It Out
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4. Place the load module into an ESD bag or container, to prevent damage while handling or
transporting it.

Software Installation for Remote Operation
For remote operation on chassis, you need to use a client component called IxExplorer. IxExplorer is
included as part of IxOS installation on chassis and can be accessed via monitor attached to chassis
itself. For client computers, standalone IxExplorer installer should be used. Both IxExplorer and IxOS
can be downloaded from Ixia website.

After downloading the installer (.exe file) on your computer, select on the file and select Run as
administrator from the context menu to start installation. The installation presents a standard set of
dialog boxes allowing users to include/exclude certain components. Please make sure Client
component is included.

The following client operating systems are certified for use with the indicated Ixia IxOS software.

l Windows 2008 Server 64-bit

l Windows 7 Enterprise 32-bit (Build 7601)

Chapter 2  Installation

– 45 –

https://support.ixiacom.com/ixos-software-downloads-documentation


l Windows 7 Professional 32-bit (Build 7601)

l Windows 7 Professional 64-bit (Build 7601)

l Windows 7 Ultimate 32-bit (Build 7601)

l Windows 2012 Server Standard R2 64-bit

l Windows 8.1 Enterprise 32-bit and 64-bit (Build 9600)

l Windows 10 Pro (Build 1803)

The following versions of Windows operating systems are no longer supported on the client:

l Windows Vista Enterprise SP2 32-bit and 64-bit

l Windows XP Professional 32-bit SP3

Note:
l Before proceeding with IxOS or IxExplorer installation, Ixia recommends you to update
Microsoft Windows Operating System version on Ixia Chassis or Client computers to
corresponding supported build version. Contact Ixia Technical Support for assistance with
Microsoft Windows Operating System update options on Ixia Chassis.

l If the target drive has insufficient storage, you may encounter 2755 error message during
installation. This is indicative of insufficient space on the system drive or target drive. IxOS
installation requires ~13 GB of space on chassis and ~5.5 GB of space on client. IxExplorer
installation requires ~2.5 GB of space on client.

Software Installation Procedure
You require admin privileges to install the software. Complete the following steps to install the
software.

1. Download a copy of IxExplorer or IxOS installer (.exe file) from Ixia website. Since you need
administrative privileges to proceed with installation, select the file and select Run as
administrator from the context menu to start installation.
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Note:
l Use IxExplorer if you only need client components and do not need server components like
Demo Server, TCL Server, and Hardware Manager. IxExplorer can only be installed on
Client computers. For all other scenarios, use IxOS installer, which also installs IxExplorer.

l If you do not have administration privileges, the User Account Control dialog box will
appear, as shown in the figure below.
Figure: User Account Control dialog box

2. A dialogue box appears providing option for changing Installer Cache path where installer and
helper files are stored. It should only be changed to a location which does not require
administrative privileges. Select Next to proceed.
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Figure: Installer cache folder selection

3. Installer starts unpacking files after which, setup progress window appears and package integrity
check is performed. Wait for the check to complete.
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Figure: Extracting files

Figure: Setup progress window
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4. After package integrity check passes, a separate welcome dialog box appears indicating that
setup is ready to begin. Select Next.
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Figure: Welcome window

If IxOS or IxExplorer is already installed on the computer, following dialog box will appear indicating
multiple installation of same application. Select Continue to proceed.

Figure: Existing application detected
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Note: IxServer should not be up and running during installation. If it is, you will be prompted to
retry installation after closing IxServer.

5. Software License Agreement window appears. You must accept the terms, to continue the
installation. You need to license the product if it is not already licensed. See Chapter 4, License
Management. Select Next to proceed.
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Figure: Software license agreement

6. Installation Option window appears. Following options are listed depending on whether
installer is IxOS or IxExplorer and whether target is a chassis or client.
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Figure: IxExplorer installation options on client
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Figure: IxOS installation options on chassis
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Figure: IxOS installation options on client

l Select the components that should be installed. Options include the following:
n Client: Installs IxExplorer and TCL consoles used to manage and configure the Ixia chassis,
load modules, and ports. Available on both IxExplorer and IxOS installation.

n Server: Installs IxServer which only boots up in Ixia Chassis, accepts connections from
client apps like IxExplorer or TCL console and communicates with or manages chassis
hardware. Available only when IxOS is installed on chassis.

n Demo Server: A pseudo-IxServer that imitates several configurable load modules. No real
traffic can be sent using the demonstration server computer. Available only when IxOS is
installed on client. Refer to Installing a Demonstration IxServer for more information.

n Tcl Server: Installs software module which implements an intermediate process needed to
support nonWindows (Unix) IxAutomate (formerly IxScriptMate), Tcl, and other client
computers. Available only when IxOS is installed. See the IxOS Tcl Development Guide for
more information on IxTclServer.

Any option selected for installation will not have a red ‘X’ in its icon. Select Next to proceed.
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Note:
l If IxServer or IxTclServer are selected, another dialog box appears that requests to define
how the server should be run. See Server Operation Option below for more information.
This however does not affect Demo Server.

l If none of IxServer, IxTclServer and Demo Server is selected, another dialog box appears
asking whether you want to install off-chassis hardware manager. See Hardware Manager
Options for more details.

7. This is an optional step which you will only see if you’re using IxOS installer, which might install
two versions of TCL as shown in figure below. Selecting any one of the TCL version will only
change the version of default TCL interpreter spawned by TCL server when it receives a
connection from TCL client. This can be changed after installation as well, using TCL Server
Launcher -> Tools -> Options. Select Next to proceed.

Figure: TCL version selection
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Figure: TCL version selection in launcher

8. After you have selected the components as per your requirement, the dialog box shows the
selected components that are ready to install, as shown in the following figure. Select Install to
proceed.
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Figure: Ready to install components

9. After several installation progress windows (such as one shown below), a dialog box will finally
appear indicating installation completion. You can view Release Notes if you select Show the
Release Notes check box. Select Finish to exit.

Figure: Installation progress

Chapter 2  Installation

– 59 –



Figure: Setup complete
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Server Operation Option
IxServer and Tcl Server start up has three control options, as shown the following figure.
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Figure: Server Operation Option dialog box

The options in this dialog box are described in Table : Server Options.

Option Function

Add to
Startup
Programs
(Typical)

If this option is selected, the server computers are part of the Windows Startup
Programs and run automatically on Windows start up. The normal User Interface (UI) is
provided, with the appropriate desktop icons.

Run as
Service

If this option is selected, the server computers run as a Windows service. There are no
desktop icons, and no UI. The server computers starts automatically with Windows.

To stop a server computer, use theWindows Service Control Manager (select the
My Computer icon, select Manage, and then Services from the context menu).
From there, you can disable or enable the server (IxServerService.)

For IxServer configuration, the service must be stopped and the UI opened through the
Ixia folder in the Start Menu. The server computer cannot be configured while running
as a service.

IxServer can be monitored using it’s log file, which is located at C:\Program Files\Ixia.

None If this option is selected, the server computers are not automatically started with

Table : Server Options
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Option Function

Windows, and must be manually started by using the appropriate icon.

Hardware Manager Options
If install options for both Tcl Server and IxServer/Demo Server are not selected, you will have an
option for installing off-chassis hardware manager, as shown in the following figure.

Note: Hardware Manager is an IxOS component that manages the resources on an Ixia chassis.
Applications such as IxNetwork communicate with a chassis through Hardware Manager. For
further information, refer to the Aptixia IxNetwork User Guide, page 2-60, topic Off-Chassis
Hardware Manager.

Figure: Hardware Manager Option dialog box

As described in the dialog box, it is advisable to install the Hardware Manager off-chassis for
applications that run tests over chassis chains.

Use the option to select whether or not to install the Hardware Manager off-chassis.
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Installing a Demonstration IxServer
A demonstration IxServer can be installed along with the IxExplorer. This is an optional choice. Once
installed, you can connect to the server computer using the locally installed IxExplorer client
computer. The demonstration version of IxServer only allows you to examine the components (that is,
a wide variety of chassis, load modules, and ports) of an artificially generated chassis chain. No real
testing can be performed.

Avoid installing both a demo mode and a real version of IxOS onto the same system.
l If a demo mode version of IxOS is installed onto a chassis, and a real version of IxOS is installed
onto the same chassis, and then the real version is uninstalled, the Ixia drivers is not removed
(because of the presence of another version of IxOS on the system) in this case. When starting
the demo version of IxOS on that chassis, the demo mode tries to start the services, but fails
because demo mode would not have installed any services.

l Similarly, when both a demo mode and a real version of IxOS are installed on a computer, and
then the real version gets uninstalled, the drivers are still present. The demo mode running on
the computer tries to read/write inaccessible data. In addition, the demo mode has the same
issues with services as described above with regard to the chassis.

l In both the cases, to correct this problem, it is necessary to uninstall both servers from the
system, and then install the Demo Server onto the remote client computer workstation, and
install the real IxServer onto the chassis.

After obtaining the IxExplorer software, follow the IxExplorer installation instructions provided in
Software Installation Procedure During the installation process, the dialog box shown in Figure:
IxServer Installation Options appears.
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Figure: IxServer Installation Options

For the demonstration server, select the option Demo Server. A menu appears, as shown in Figure:
IxServer Installation Options.
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Figure: Installation Option selection

Select either the first or second option. The demonstration version of IxServer is installed on the local
computer (typically a workstation).

Shell Wrapper Installation
You must install the shell wrappers in /opt/ixia/ixos-api/<version>/bin folder to execute the ixTcl and
ixwish tests.

l ixnettcl : Sets TCLLIBPATH and calls the ixiatcl8.5.17 link in /usr/bin. To execute Tcl script,
execute ixnettcl <lowLevelScriptName>

l ixnetperl : Sets PERL5LIB and calls the ixiaperl5.18 link in /usr/bin. To execute Perl script,
execute ixnetperl < lowLevelScriptName >

l ixnetpython : Sets PYTHONPATH and calls the ixiapython2.7.6 link in /usr/bin. To execute
Python script, execute ixnetpython < lowLevelScriptName >

l ixnetwish : Sets TCLLIBPATH and calls the ixiawish8.5.17 link in /usr/bin. To execute Wish script,
execute ixnetwish < lowLevelScriptName >

Note: For more information on the Tcl, Perl, and Python settings scripts, see the IxOS Tcl
Development Guide.
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Unix/Linux Operation
IxExplorer is a Windows-only application. You can access the IxOS Tcl APIs from a Unix or Linux
environment using IxTclServer and a Tcl client computer. For specific information on how to use
IxTclServer and the Tcl client computer, see the IxOS Tcl Development Guide.

Note:
PIT Notes:

The Platform Independent tgz packages do not contain Perl, Python or TCL interpreters. The Ixia
dependencies (mpexpr and snit) are also not included. Download the all-in-one language
packages and dependencies installer for Linux x86 and x64 to use with any app Platform
Independent TCL installer from the Ixia website.

Automatic Update Feature

Preparing to Install
Follow the steps to prepare to use the Automatic Update functionality:

1. Locate the install package named Ixos<version.version>.exe (for example, IxOS5.10SP1exe).
Extract this to the network location. This install package can be downloaded from the Ixia
Website and it is included on the product CD.

2. Extract the installer files from the install package by using the following command:
Ixos<version.version>.exe -s -e -f <extraction path>

3. Install the chassis from the same network path. Use the setup.exe in the same folder to install
the chassis.

Using Automatic Update
The versions of IxExplorer client computer and IxServer must be synchronized, otherwise they cannot
operate together. It is possible to automatically update the version of the client computer to the server
computer using the Automatic Update feature.

Note: The chassis Icon in IxExplorer is a purple color when its IxServer is using a different
version of the software than the IxExplorer client computer.

When trying to connect to a server computer with a different version than IxExplorer, the dialog box
shown in Figure: Auto-Update Warning appears.
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Figure: Auto-Update Warning

Select OK (the warning message closes). From the Tools menu, select the IxOS Upgrade option, as
shown in the following figure.

Figure: IxOS Upgrade Option

The dialog box that appears is shown in the following figure.

Figure: IxOS Client Software Upgrade

The IxOS Client Software Upgrade dialog box displays the current version of the client computer
software and the server computer software. Select Continue to begin upgrading the client computer
software.
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Note: This feature works only if the following criteria are observed:
l The initial installation of the server software must be done from a network folder using the
setup.exe (provided with Ixia installer package).
The network folder cannot be a mapped drive; it must be a UNC path.

l The IxOSUpdateTemplate.bat file must also be in the network folder.

l The server installation folder must be accessible to both the workstation that the IxExplorer
client computer is installed on, and the chassis that IxServer is installed on.

l The path to the network folder must be the same folder path for both computers.

l In some instances, the anti-virus software prevents proper updating of the IxOS software.
Disable anti-virus software before using the Auto-Update feature.

IxOS Silent Install
IxOS Silent Install is a feature which enables you to install IxOS software unattended. A silent
installation of IxOS is ideal for test scenarios or as part of a large-scale enterprise deployment.

You may use the IxAdmin package to perform remote silent installations on multiple computers at the
same time.

If you want to use Silent Installation to install IxOS software on an Ixia chassis, you must change the
policy that controls Silent Installation. See Preparing an Ixia Chassis for Silent Installation.

IxOS product silent install setup is discussed inIxOS Silent Install by .exe Package.

IxOS silent install setup for LINUX is discussed in IxOS Silent Install on LINUX.

Preparing an Ixia Chassis for Silent Installation
If you try to run a Silent Install on an Ixia Chassis with Windows installed, Windows displays the
following warning message for the Ixia kernel driver:

Signature Not Found

To prevent this warning, you must change the Windows policy that governs the installation of unsigned
drivers. Follow the steps below. You only need to use this procedure once.

1. On the Ixia chassis, select Start, select Run, and then type MMC, and select OK.

2. Select Add/Remove Snap-in, on the Console menu.

3. Select Add and select Group Policy and select Add.

4. Select Finish/Close/OK.

5. Navigate down the following tree:
Console Root
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Local Computer Policy

Computer Configuration

Windows Settings

Security Settings

Local Policies

Security Options

6. Select unsigned driver installation behavior and select Security from the context menu.

7. Change the Local policy setting to Silently succeed.

8. Select OK.

Note: It is necessary to restart the chassis after this operation.

IxOS Silent Install by .exe Package
Setting up the silent install for IxOS for a chassis involves activating specific features included in the
product package, and specifying the server operation mode through a command prompt.

The available features and properties (operation modes) are delivered as part of the installer. Table:
Features lists the features available, and Table: Properties lists the properties.

To run the IxOS installer silently, use the IxOS<version>.X.X.exe package, where <version> is the
version of the software, and X.X is the build number for the particular package. The command line to
extract the setup is like “IxOS_X.XX_EA.exe /s /extract-only". It caches to location \Program
Files\IxiaInstallerCache\IxOS\X.X.X.X where X.X.X.X is the build number. The setup.exe file is located
in this folder.

The following steps demonstrate how to set up silent installation through the .exe package.

1. Open a command prompt.

2. Enter the following command argument, in one line:

setup.exe [-s|-q] [-n] [i|x|r] [F.Feature1=Yes|No [F.Feature2=Yes|No]]
[P.Prop1=Val1 [P.Prop2=Val2]]

See IxOS setup.exe Package Example below for examples of using the command prompt to set up
silent installation.

Switch Definition

-s silent (progress bar only)

-q quiet (no GUI at all)

Table: setup.exe Switches
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Switch Definition

-n external controlled (by IxAdmin)

no switch
(default)

GUI installation

Table: setup.exe Switches

Switch Definition

i install

x uninstall

r repair

no action
(default)

install

Features

F.Feature1=Yes—install the named feature.

These features represent installer components and are detailed in config.xml file, in the
ConfigOptions/CannedConfig section. If no features are provided, a default configuration is used.

Features represent the installer components that can be selected from the GUI in standalone mode.
The command prompt allows the combinations of these features.

Feature Definition

F.Client install Client

F.Server install Server

F.TclServer install Tcl Server

F.DemoServer install Demo Server

F.HWManager install Hardware Manager

Properties

P.Prop1 =Val1—pass to the installer a certain property.
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If no properties provided, default properties is used.

Properties correspond with settings from the installation GUI, but do not represent the standard
features from the feature selection dialog box. Rather the options are presented as option buttons,
check boxes, or edit fields (like the choice of TCL version in IxOS). A special property is InstallDir
which (if accepted by the application installer) sets the installation folder.

Property Definition

P.RUNMODE = 1 Server is running like Service

P.RUNMODE = 2 Server is running like Add to Startup

P.RUNMODE = 3 None - manual mode

P.TCLVERSION=8.5 to install TCL 8.5

P.InstallDir sets the installation folder

IxOS setup.exe Package Examples
The following examples demonstrate various options when setting up silent installation using the
setup.exe package:

l Silent Install, IxOS Server::

Setup.exe –s F.Server=Yes
l Quiet Install, IxOS Server:

Setup.exe –q F.Server=Yes
l Quiet Install, IxOS Client with Tcl 8.5

Setup.exe –q i F.Client=Yes P.TCLVERSION=8.5
l Silent Uninstall (any config)

Setup.exe –s x

The table below represents the detailed list of the configuration and corresponding commands for IxOS.

IxOS configuration to
install Command line

Client with TclServer (add to
startup)

Silent : setup.exe –s F.Client=Yes P.TCLVERSION=”8.5”
F.TclServer=Yes P.RUNMODE=2

Quiet : setup.exe –q F.Client=Yes P.TCLVERSION=”8.5”
F.TclServer=Yes P.RUNMODE=2

Controlled by IxAdmin: setup.exe –s –n F.Client=Yes
P.TCLVERSION=”8.5” F.TclServer=Yes P.RUNMODE=2

Table: Command Lines for IXOS
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IxOS configuration to
install Command line

Client setup.exe –s F.Client=Yes P.TCLVERSION=”8.5”

Client with HWManager setup.exe –s F.Client=Yes F.HWManager=Yes
P.TCLVERSION=”8.5”

TclServer (add to startup) setup.exe –s F.TclServer=Yes P.TCLVERSION=”8.5”
P.RUNMODE=2

Server (add to startup) setup.exe –s F.Server=Yes P.RUNMODE=”2”

Server (run as service) setup.exe –s F.Server=Yes P.TCLVERSION=”8.5” P.RUNMODE=”1”

Server (start manually) setup.exe –s F.Server=Yes P.TCLVERSION=”8.5” P.RUNMODE=”3”

Client, TclServer and Server
(add all to startup)

setup.exe –s F.Client=Yes F.Server=Yes F.TclServer=Yes
P.TCLVERSION=”8.5” P.RUNMODE=”2”

Client, TclServer and Server
(start all manually)

setup.exe –s F.Client=Yes F.Server=Yes F.TclServer=Yes
P.TCLVERSION=”8.5” P.RUNMODE=”3”

Client, TclServer and Server
(start all as services)

setup.exe –s F.Client=Yes F.Server=Yes F.TclServer=Yes
P.TCLVERSION=”8.5” P.RUNMODE=”1”

TclServer with Server (add
both to startup)

setup.exe –s F.Server=Yes F.TclServer=Yes P.TCLVERSION=”8.5”
P.RUNMODE=”2”

TclServer with Server (start
both as services)

setup.exe –s F.Server=Yes F.TclServer=Yes P.TCLVERSION=”8.5”
P.RUNMODE=”1”

TclServer with Server (start
both manually)

setup.exe –s F.Server=Yes F.TclServer=Yes P.TCLVERSION=”8.5”
P.RUNMODE=”3”

Demo Server and TclServer
(add both to startup)

setup.exe –s F.DemoServer=Yes F.TclServer=Yes
P.TCLVERSION=”8.5” P.RUNMODE=”2”

IxOS Silent Install on LINUX
To install IxOS on Linux in silent mode, do the following:

1. Create a response file using <installer> -r <path to silent response file> command line. The
response file will record the user inputs provided during console installation.
Example: ixosX.X.X.XLinux.bin -f /home/ixsdk/user/response1.txt

2. Install IxOS using the response file.

Example: ixosX.X.X.XLinux.bin -f /home/ixsdk/user/response1.txt -i silent
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Uninstall/Modify a Current Installation
To remove silently the current version of IxOS, uninstall it entering the following argument at the
command prompt:

Setup.exe –s x

To modify an existing installation, first uninstall it, and then reinstall it with the desired features.

Silent Repair/Modify
Silent repair is the same as running silent install on a current installation. Enter the following at the
command prompt:

setup.exe -s r

Multi Version Installation and Management
Beginning with IxOS 5.10 SP2, multi-version support is present in the Ixia operating system. Multiple
versions of IxOS can be present on the client computer, as well as multiple versions of applications
such as IxLoad or IxNetwork. You can select from the different versions of IxOS to maintain
compatibility with the application that you are running.

Benefits
The benefits of multi-version installation are as follows:

l You can incorporate multiple versions of IxOS on a testbed.

l If you need to downgrade, you no longer have to uninstall/reinstall; you can simply start the
other version of IxOS.

l The Licensing model still remains the same.

l This new model also extends into applications. So multiple application versions can co-exist in
the future.

Caveats
l Only a single version of IxServer can be running at any one time.

l IxOS 8.00 does not co-exist with older versions of IxOS. The older versions need to be
uninstalled before upgrading.
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l Client computer/chassis version matching does not change. So a Client computer with IxOS 5.10
SP3 still abides by the same restrictions if attempting to connect to a chassis running IxOS 5.10
SP2.

l There are changes made to the installer. When installing this new version of IxOS, you may
choose to first uninstall the existing version of IxOS. Alternatively, if the current version of IxOS
supports multi-versions, a co-exist option is present. See Installation Changes.

l Each version of IxOS installs into its own folder on C:\Program Files\Ixia\IxOS\version xx. The
folder C:\Program Files\Ixia contains other Ixia-dependent applications; so any uninstalling and
deleting of application files must be limited to the specific version folder.

After uninstalling version X of an application, you may alternatively use Windows Explorer to delete
files from the version X folder only. Be careful not to delete any files outside the version X folder
because those files are accessed by other versions and other applications.

l Demo server also supports multi-version intallation. However, see note under Installing a
Demonstration IxServer for a caution regarding installing demo server computer and IxServer
onto same workstation.

l .ixs files are not migrated by the installer. So if a new IxOS version is being installed to co-exist
with a current version, it does not migrate the existing .ixs. It installs a new .ixs in its own folder.

l Both ActiveState Tcl 8.5 and 8.6 are now installed with IxOS. See ActiveState Tcl 8.5 for details.

ActiveState Tcl 8.5 and 8.6
Both ActiveState Tcl 8.5 and 8.6 are installed with IxOS, beginning with IxOS version 8.50 EA. Existing
scripts written with Ixia’s version of Tcl 8.4 and Tcl 8.5 is compatible with Activestate Tcl 8.5 and 8.6.
Shipping with ActiveState Tcl allows Ixia to standardize the version of Tcl across all Ixia apps.
ActiveState Tcl is the predominant software that Ixia customers use when they have their own Tcl.

Support for ActiveState Tcl

Commercial support for ActiveState Tcl is available through ActiveState at:
http://www.ActiveState.com/enterprise-edition. For peer support resources for ActiveState Tcl issues
refer: http://www.ActiveState.com/Support/.

IxOS and ActiveState

ActiveState Tcl 8.6 is the up-to-date, quality-assured binary distribution from ActiveState. Current
releases, and other professional tools for open source language developers are available at
http://www.ActiveState.com.
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Version Management Tools
Two new tools, AppInfo and Application Selector, are both installed automatically during IxOS
installation. Application Selector can be started by selecting the icon on the desktop.

AppInfo

The AppInfo tool is for managing multi-version installations. AppInfo makes automated choices,
matching a version of an application with the appropriate version of IxOS. The AppInfo tool
automatically selects the highest compatible version of IxOS unless you override the choice.

Application Selector

The Application Selector tool is used to override the automatic selections made by AppInfo during
installation. You can choose a specific version of IxOS to run with a selected application. The
Application Selector shows only applications that are currently loaded onto the client computer. When
a new application (or new version) is loaded, it shows up in the Application Selector next time the
Selector is opened.

Installation Changes
The folder structure of the Ixia group has been modified. Applications are no longer loaded to the Ixia
folder, but into specific folders for each application and each version. The applications can be accessed
through icons on the desktop, or during installation you can choose not to install the icons.

When installing multi-version IxOS, one of following three scenarios may occur:

a. Installation of a multi-version IxOS when there is an existing non-multiversion instance.

b. Installation of a multi-version IxOS when there is a pre-existing multi-version instance.

c. Installation of a multi-version IxOS when there are multiple pre-existing multi-version IxOS
instances.

When scenario b (above) is true, a dialog box similar to the following appears.
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Figure: Multi-version Installation

During the IxOS installation process, the following new dialog box appears as AppInfo is configured
(Figure: Ixia AppInfo Installation).
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Figure: Ixia AppInfo Installation

After the installation completes, following installation screen appears. You must install Wireshark
separately for Capture View and Analysis.
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When Application Selector is opened, the window similar to the following figure is displayed.

Figure: Initial Application Selector Window

Select an application version in the left pane, to view the dependencies in the right pane, as shown in
the following figure.

Figure: Application Selector with IxOS Version Selected

For example, Application Selector indicates that, for IxOS version 8.40.1400.5, the compatible version
IxNetwork 8.50.1501.4, is installed. It also indicates the default No override selection for the Tcl
version.

Select the Tcl version, and the dependencies are displayed as shown in the following figure.
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Figure: Application Selector with Tcl Version Selected

Application Selector indicates that Tcl version 8.5.17.0 has no dependencies.

Chapter 2  Installation

– 80 –



Figure: Application Selector with Wireshark Version Selected

Repair, Modify, Uninstall using Windows Control Panel
In addition to the Silent Repair/Modify procedure, you can use the Windows Control Panel to uninstall,
modify, or repair the IxOS software. The following circumstances may indicate using this approach:

a. Uninstall the IxOS software: Use the Remove dialog box.

b. Modify: This allows to add or remove specific components involved in the IxOS installation. For
example, if only the Tcl client was installed, and the Tcl Server was not installed, you can use the
Modify dialog box to install the Tcl Server. Or, if you have installed the Demo Server and want
to remove it, you can use this dialog box.

c. Repair: If you notice some missing files in the installation that may have been deleted or
modified, you can use the Repair dialog box.

To uninstall the IxOS software, do the following:

1. From the Windows Start menu, select Settings->Control Panel.

2. From the Control Panel, double-click the Add or Remove Programs option.

3. Highlight IxOS. Select Change.
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When you select Change, the Program Maintenance dialog box appears. The dialog box is
shown in the following figure.

Figure: Program Maintenance Dialog Box

4. Select Remove, and then select Next.

Windows Installer opens the Remove the Program dialog box. The dialog box is shown in the
following figure.
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Figure: Remove the Program Dialog Box

5. Select Remove.

Windows Installer displays a dialog box as it removes IxOS from your computer. The dialog box
is shown in the following figure.
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Figure: Uninstall Status Dialog Box

After the uninstall operation is complete, Windows Installer displays the Setup Complete
dialog box as shown in the following figure.
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Figure: Uninstall Complete dialog box

6. Select Finish.

7. Close the Add or Remove Programs window.
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CHAPTER 3 Using IxExplorer
This chapter describes the requirements for and provides detailed instructions for using IxExplorer, the
IxOS graphical use interface (GUI). It contains the following topics:

l Introducing IxExplorer

l Packet Streams (Transmit Generation) describes the process of defining and configuring data
flows to be transmitted from a port.

l Using Capture on page 91 describes how data is captured on a port and then displayed in useful
ways.

l Tutorial # 1: Transmitting Your First Data

l Tutorial # 2: Capturing Your First Transmitted Data

l Filters and Triggers describes comprehensive filters and triggers that enable you to capture and
count received packets based on configurable matching conditions.

l Statistics describes how to view all or a subset of the statistics available for chassis ports.

l Multiple Statistics View

l Port Properties

l Useful Tricks

Introducing IxExplorer
The IxExplorer software provided with this product follows the Microsoft Windows Explorer paradigm for
a standard, easy-to-use interface. It is assumed that the person using this product is familiar with the
Windows user interface and terminology such as ‘double mouse click’ or selecting from context menu to
either invoke an action or provide more information.

The IxExplorer software provides complete configuration, control, and monitoring of Ixia resources in
the test network.

To establish communication between IxExplorer and each chassis, the Host ID or IP address of each
chassis must be known. If you did not collect the Host ID during initial configuration (steps 12-14 in
the Initial Configuration section) or the actual IP address assigned to the chassis (step 10 in the Initial
Configuration section), the chassis ID information for the chassis can be accessed by selecting the
Network Neighborhood icon on the Windows desktop, and selecting Properties from the context
menu. In the Network dialog box, select the Identification tab. The chassis ID is located in the
Computer Name box.

Once this ID is known, go to the IxExplorer pane in Explore Network Resources window,selct the
chassis option in the pane, and select Properties from the context menu. The Host ID or IP address
can be entered in the IP Address box. The chassis ID should be set to a unique number with respect
to other chassis that you might connect together at your facility.
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Once the contact between IxExplorer and the chassis is established, the indicator next to the chassis
in the pane goes from red to yellow to green. IxExplorer uses the Microsoft Windows Explorer paradigm
for a standard, easy-to-use interface. Users who are familiar with Windows are likely to be able to
configure and run a basic transmit-and-capture Ethernet packet stream test within two or three minutes
of first power up. IxExplorer configures and controls traffic generation, monitors statistics, views, and
decodes captured packets. The scalable interface can be used across multiple chassis concurrently for
seamless operation of large configurations.

Figure: Example of IxExplorer Window After Starting IxExplorer

Figure: Example of IxExplorer Window After Expanding the Tree
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Packet Streams (Transmit Generation)
Packet Streams are user-defined configurations that allow to define and configure data flows to be
transmitted from a port. A Packet Stream configuration contains parameters that control the format of
generated frames, such as preamble size, destination and source addresses, packet type identifiers,
data payload, packet size, inter-frame gap, forced errors, CRC values, and other frame contents.
Stream Control parameters allow to define the relationship of streams to other streams, whether
continuous, sequential, interrupt, or end stream, with looping to the beginning of a list of streams. In
this way, you can create complex and continuous data flows.

The first time a chassis is powered up after shipment from the factory, each port has default settings for
Packet Streams and Capture Filters. The Packet Stream default configuration is to send a continuous
stream of valid 64-byte packets with minimum interframe gap, with all zeroes in the destination and
source addresses, plus incrementing bytes in the data field. The Capture Filter default configuration
allows all packets to be captured. The following tutorials assume that you are using the default
configurations. After they are changed, the changes are retained so the tutorials may no longer run as
specified.

Tutorial # 1: Transmitting Your First Data
In this example, we transmit a continuous 64-byte packet stream, with a destination address of 00 00
00 00 00 00, a source address of 00 00 00 00 00 00, incrementing data bytes, and good CRC values.

The Resources pane appears on the left side of the IxExplorer window. Under Resources on the
pane, there is Chassis Chain01, and under this there is Chassis 1. The round indicator on the left
side of Chassis 1 should be green, indicating that the IxExplorer software has established
communications with the server agent running on the chassis.

To transmit data, do the following:

1. Double-click Chassis 1, and you see all Cards that are installed in the chassis, labeled by the
number of the slot that they occupy.

2. Select one of the cards to send and receive the packet stream.

3. Install a jumper cable from port 1 of that card to port 2 of that card. If the card is a 10/100 Mbps
Load Module, use an Ethernet crossover jumper cable. If the card is a Gigabit Load Module, use a
duplex fiber jumper cable.

4. Double-click the card in the IxExplorer pane to display the ports for that card.

5. Select port 1, and select Start Transmit from the context menu.

6. You are now transmitting your first packet stream from port 1 on the card to port 2 on the card.
The indicators on the front of the card reflects this, with the Tx/Coll LED on port 1 lit, and the
Rx/Err LED on port 2 lit. Both LEDs should be green, indicating good data. You can stop the
packet stream by selecting the card, and selecting Stop Transmit from the context menu.

To look at the packet stream configuration for the stream of packets that you just sent, you can select
Packet Streams under the port in the pane, and then double-click packet stream 1 that appears in
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the window to the right of the pane. This corresponds to the first of the streams of data to be
transmitted. When you double-click, a tabbed dialog box opens, which contains all of the user-
definable parameters for Packet Streams configuration.

Parameters Usage

Preamble Size Variable from 2-255 bytes

Data Pattern Wide range of user-definable patterns

Frame Size Variable from 12-65535 bytes

DA/SA Definable, with many increment and decrement options

Protocol 802.3 or Ethernet V.2 formats, IP type (more types in the future)

UDF 1, 2, 3, 4 User-defined fields with many pattern and size options

Insert Time Stamp and Port ID For packet tracking purposes and other data analysis

Force Errors Bad CRC, no CRC, alignment (10/100 only), dribble (10/100 only)

Table: Tutorial One Frame Data Tab

Parameter Usage

Enabled
Features

Continuous packet, continuous burst, stop after this stream, advance to next stream,
go to any stream with or without a count

Inter-
Packet Gap

From below minimum to many seconds

Inter-Burst
Gap

From below minimum to many seconds

Inter-
Stream Gap

From below minimum to many seconds

Table: Tutorial One Stream Control Tab

It is very informative for a new user to experiment with these packet stream parameters and view the
capture view results.

Chapter 3  Using IxExplorer

– 89 –



Figure: Default Packet Stream Settings: Frame Data

Figure: Default Packet Stream Settings: Stream Control
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Using Capture
The Capture View shows the data captured on a port. The settings of the capture filter for that port
determine which packets are shown in the capture view (more on this later). The capture view window
is split into three panes, top downwards. The top pane is a list that contains columns for a frame index
number, a time stamp, the destination address, the source address, the packet data, the frame length,
and the error status of the frame. The middle pane contains a text decode of the contents of the packet
selected in the top window. The bottom pane contains the hexadecimal byte display of the contents of
the selected packet.

Figure: Example of the Capture View Window

Tutorial # 2: Capturing Your First Transmitted Data
In this example, we take a look at the actual packets that are transmitted when we run the packet
stream in tutorial #1. We will be referring to the same card and ports as used in that tutorial.

1. Select port 2, and select Start Capture from the context menu.

2. Select port 1, and select Start Transmit from the context menu.

3. Select port 1 again, and select Stop Transmit from the context menu.

4. Select port 2, to highlight it.
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5. To the right of the pane, you see four items: Capture view, Filters, Packet Streams, and
Statistics. Double-click Capture View.

6. A window opens that displays the packets captured on port 2 when port 1 transmitted its packet
stream. You have just captured your first packet stream.

Filters and Triggers
Comprehensive filters and triggers allow to capture and count received packets based on configurable
matching conditions such as destination address, source address, data payload pattern matches, and
packet error types. There is a trigger to start capture, and filter to define what is allowed into the
capture buffer once the trigger occurs. There are also four user-definable statistics counters that may
be configured using the same matching conditions as the trigger and filter definitions. Double-click the
Filter, Statistics, Receive Mode option in the right pane. The dialog box as shown in the following
figure appears.

Figure: Default Capture Filter Settings

Statistics
The Statistics feature of IxExplorer allows to view all or a subset of the statistics available for chassis
ports. Statistics for multiple ports can be displayed side-by-side for greater insight into overall traffic
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patterns. To view the statistics for a single port, double-click Statistics under the port on the pane as
shown in the following figure.

Figure: Example of the Statistics Window for Gigabit Cards
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Statistics Counters
The counters that appear in the statistics windows for each type of Load Module are the ones that are
applicable to the Load Module type. For example, there are collision counters for 10/100 Load Modules,
but not for Gigabit Load Modules, since there is no such thing as a collision on Gigabit Ethernet. All
counters are 64-bit values. The Rate column shows the count rate values for each counter in
increments per second.

A complete listing of all items displayed in the statistics windows for different modes of operation can
be found in the Ixia Platform Reference Guide.

Multiple Statistics View
To display multiple ports statistics side-by-side, select Statistic Views in the pane and select New
from the context menu. This opens a window where you can select the ports to view statistics for in a
side-by-side display. On the left side of the window, highlight the desired ports using either the shift-
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select or control-select methods, and then select Add to place them in a list on the right side of the
window. Select OK. The statistics window appears.

The default counters in this view are only the counters that are common to both 10/100 and Gigabit
Load Modules. If you want to include counters that do not appear in this view by default (for example,
Collisions), you can add them to the view. From a statistics window that does contain the desired
counter, you can drag-and-drop the counter into the multiple ports statistics view window. Also, the
rate counters do not appear by default, and they can be added in the same way. If you want to re-order
the list of counters in the window, you can re-arrange them as desired using the same drag-and-drop
method.

Port Properties
To change or view the configuration of a port, select the port on the pane and select Properties from
the context menu. This allows to view and configure parameters such as loopback, port speed, duplex
mode, MII register settings, and other port-specific operating characteristics.

Useful Tricks
To copy a port’s properties from one port to another, select a port and drag it on top of another port on
the tree.

To start packet streams on all of the ports on one card, select the card in the pane and select Start
Transmit from the context menu. Similarly, you can stop packet streams, and start and stop capture
for all ports on a card.

To start packet streams on all ports on all cards in a chassis, select the chassis in the pane and select
Start Transmit from the context. Similarly, you can stop packet streams, and start and stop capture
for all ports on all cards in a chassis.

To rearrange the statistics counters in a statistics view, select and drag the counters to the desired
location. In this way you can arrange the statistics counters into any order desired.
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CHAPTER 4 License Management
This chapter describes Ixia software license management. It contains the following topics:

l Introduction

l Types of Licenses

l Licensing Models

l Prerequisites

l Tcl Notes for use with Licensing

l Installation Scenarios

l Installing Ixia Licensing Utility

Introduction
Ixia's license management system. Ixia Licensing Utility (ILU) and License Server Plus (LS+)
replace Ixia Registration Utility (IRU) and License Server (LS). ILU enables you to do the
following:

l Centralize and monitor your software usage.

l Maintain an accurate license inventory.

l Smoothly transfer licenses across different hosts and teams.

Offline activation and deactivation of licenses are also available now.

The Activation Code for the purchased Ixia product(s) is sent in an e-mail message, when you
purchase an Ixia software. Enter this Activation Code in ILU  to generate a license. For the licensed
software to work properly, licenses must be activated on-site. License activation for an Ixia product
can be done after the software installation but must be done before the software usage.

The licensing operation is done with a simple wizard and can be run in the following ways:

l The same computer on which the software was installed

l Some other Windows-based computer with the following minimum system requirements:
n Microsoft® Windows® XP, Microsoft® Windows® 7 and later

n 1 Ghz or higher processor

n 512 MB of RAM

n 950 MB of free hard drive space (x86)

n 2.1 GB of free hard drive space (x64)

The computer used to perform the licensing process must be connected to the Ixia chassis and to
workstations in the lab environment. If at all possible, it should also be connected to the Internet. If
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simultaneous connections to the lab network and Internet are not feasible, it is still possible to
complete all licensing operations. The offline activation and deactivation processes are covered in
Overview of Offline Activation/Deactivation section of the Ixia Licensing Management User Guide.

During the IxOS installation process, a dialog box appears that shows several options for licensing
information. The following figure shows the dialog box as it appears.

Figure: Licensing Prompt

The following table explains the options in the licensing prompt.

Options Description

Install
permanent
license

Runs the registration process. You must have purchased a license and received a
licensing e-mail with a registration number and password.

Selecting this option starts the license installation process.

Install license
later

Skips the licensing process and continues with the installation. IxOS does not run
without a valid, registered license.

If you select this option, at some point it is necessary to run the Ixia Licensing
Utility (ILU), and register the software.

Table: Licensing Options

For IxOS, only IxServer is licensed. The IxExplorer client can be installed anywhere, as many times as
needed, without a license. A license is also required when using the Windows Control Panel to modify
or repair the IxOS software. In any instance where a license is not available, a temporary license is
offered. For example:
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l If the IxOS installer is started and the SERVER option is selected, the Ixia Licensing installer is
installed and the dialog box to acquire a temporary license appears.

l If MODIFY is selected in the Add/Remove programs dialog box, Licensing is not installed if
IxServer is already installed. Select Repair to acquire a temporary license in this case.

l If the IxOS installer is started and only the CLIENT option is selected, Licensing is not installed
and no licensing dialog box appears.

l If MODIFY is selected in the Add/Remove programs dialog box, and the SERVER feature is
selected for installation (where previously only the client feature was installed), licensing is
installed and the dialog box to acquire temporary licenses appears.

Types of Licenses
Ixia provides the following types of licenses for its products:

l Node-Locked Licenses

l Floating Licenses

l Evaluation Licenses

Node-Locked Licenses
Node-locked licenses are locked to a particular chassis or workstation and allow only certain product
functions to run on that chassis or workstation.

Floating Licenses
Floating licenses are stored on a license server and allow a set number of chassis or workstations to
use product software features. All chassis or workstations that use this type of license must be
connected to the license server and the server must be up and running. Once the set number of users
is reached for that particular feature, additional users for the product features are denied.

Note: You can mix both node-locked and floating licenses to get the best solution according to
your testing environment.

Evaluation Licenses
Evaluation licenses evaluate Ixia products. Except for a time limit, they act in all respects as a regular
license (must be activated using ILU).
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Licensing Models
Ixia provides the following licensing models for its products:

l Subscription Licenses

l Perpetual Licenses

Subscription Licenses
Subscription licenses are floating and limited licenses, stored on a license server. They are checked
out from the defined license servers and allow only a limited number of licenses to be used
concurrently.

Note: For specific details on subscription licenses, please refer to the documentation of your
product of interest.

Perpetual Licenses
Perpetual licenses are node-locked licenses, stored on a chassis. They are checked out from the
individual chassis and cannot be installed on a different license server.

Note: For specific details on perpetual licenses, please refer to the documentation of your
product of interest.

Prerequisites
Before activating a license, you must have the following:

The e-mail message from Ixia with the activation code. The key contents of this e-mail message are as
follows:

l Entitlement Code: If you provide the entitlement code, ILU loads all the available activation
codes associated with that entitlement code.

l Product: The product name for which the license is being activated.

l Quantity: The number of licenses.

l Activation Code: A unique number for the license.

l Start Date: The date from which the license can be activated.

l End Date: The date on which the license will expire.
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Tcl Notes for use with Licensing
Although the GUI offers the ability to designate an independent license server as a menu option, no
such option is available to a Tcl program. Instead an environment variable named IXN_LICENSE_
SERVER must be set.

If you are running your Tcl program on a Unix client computer, the environment variable must be set on
the host running the TclServer. If you are running your Tcl program on a Windows client computer, it
must be set on that client computer. Environment variables are set on a Unix host through the user’s
shell initialization script.

To set the environment variables on a Windows host, do the following:

1. Select My Computer on the desktop and then select Properties from the context menu.

2. Select Advanced tab from the System Properties dialog box.

3. Select Environment Variables at the bottom of the page.

4. In either User variables for <user> or System variables list, if IXN_LICENSE_SERVER does
not exist in the list, select New, or else Edit.

5. The name of the variable should be IXN_LICENSE_SERVER and the value should be the name or
IP address of the license server computer.

Installation Scenarios
These installation scenarios are described in the following sections:

l Licensing to a Chassis or Workstation via the Internet

l Licensing to a License Server via the Internet

l Licensing to a Chassis or Workstation without the Internet

l Licensing to a License Server without the Internet

The Installation Host is the computer that is used to perform the licensing installation. This can be the
same computer on which the Ixia software was installed, an Ixia chassis, a License Server, or a
separate workstation.

Licensing to a Chassis or Workstation via the Internet
In this case, the Installation Host is connected to the Internet and licenses are installed to the
workstation or Ixia chassis to which the license pertains (the workstation and the Installation Host can
be the same computer). The Installation Host must also be connected to the workstation/chassis (if
they are not the same computer) as shown in the following figure.
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Figure: Licensing to a Chassis or Workstation through the Internet

Licensing to a License Server via the Internet
In this case, the installation host is connected to the Internet and licenses are installed on a central
license server (the license server and the installation host can be the same machine). The installation
host must also be connected to the license server and the workstation/chassis (if the license server
and the installation host are not the same machine).
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Figure: Licensing to a License Server via the Internet

Licensing to a Chassis or Workstation without the Internet
In this case, the Installation Host is not connected to the Internet and the licenses are installed to the
workstation or Ixia chassis to which the license pertains (the workstation and the Installation Host can
be the same computer). The Installation Host must also be connected to the workstation/chassis (if
they are not the same computer).

To complete the installation process, an additional computer is necessary—an Online Host, as shown
in the following figure. This computer must be connected to the Internet. It is necessary to transfer
small amounts of information from the Online Host to the Installation Host to complete the process. E-
mail or a portable USB drive may be appropriate.
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Figure: Licensing to a Chassis or Workstation disconnected from the Internet

Licensing to a License Server without the Internet
In this case, the installation host is not connected to the Internet and licenses are installed on a
license server (the license server and the installation host can be the same machine). The installation
host must also be connected to the license server and the workstation/chassis (if the license server
and the installation host are not the same machine).

In order to complete the installation process, an additional computer is necessary – an online host –
shown in the figure below. This machine must be connected to the Internet. It is necessary to transfer
small amounts of information between the online host and the installation host to complete the
process. E-mail or a portable USB drive may be appropriate.
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Figure: Licensing to a License Server disconnected from the Internet

Installing Ixia Licensing Utility
For details on installing Ixia Licensing Utility, refer to the Ixia Licensing Management User Guide.
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